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Introduction

Introduction

These notes describe how to install Easy5 2018 on a computer running the Windows® 7 or Windows 10
operating systems. You should review these notes before installing EasyS. Keep these instructions
with the Easy5 User Guide for future reference.

Please refer to the Easy5 Release Guide for additional information about using Easy5 on Windows
operating systems.

Notes:  For the latest information on supported platforms for upcoming releases of MSC
products, please visit the following web site:
http://www.mscsoftware.com/Support/Platform-Support/Default.aspx

« The MSC Licensing software is now delivered via its own Product Page on the SDC.
Installers for the MSC Licensing software are provided on a number of hardware
platforms. Delivering the MSC Licensing software separately from the individual MSC
products allows us to provide you with updates to the licensing software more
effectively. If there are any questions, please contact MSC Technical Support for
assistance.

+ Some sections of the Installation Notes and Release Guide are duplicated for ease-of-
use.
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Conventions Used in This Guide

This guide uses the following text conventions to identify functions and procedures:

+ Text in a Courier font indicates a file name or text to be entered.
Enter open loop in the input field.

+ Text enclosed in angle brackets indicates that you are to press a key.
Press <Enter>.

+ Most keyboard shortcuts require that you press the Control key together with another key.
Press Ctrl + S.

« Text in a bold Arial font with right angle brackets between words indicates that you select a
menu and subsequent submenus with your mouse.

Go to File > Print Preview to view your document.
« Text in an bold font indicates that you are to select a button to perform an action.
Click OK to close the window.

o Indented items in italic text are notes used to highlight certain informational points.
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Minimum System Requirements

Minimum system requirements for installation and use of EasyS5:

« Intel (or compatible) processor-based computer running Windows 7 or Windows 10.
+ Intel 64-bit architecture (EM64T)

+ 256 MB of RAM.

+ 700 MB of free space for a complete program installation.

+ CD-ROM drive if installing from a CD-ROM.

« Mouse or pointing device.

+ Video display card and monitor combination providing at least 1,024 by 768 pixels of graphic
resolution at 60 Hz with 256 colors.

+ An Easy5-compatible Fortran compiler (Intel Visual Fortran 13.x, or GNU gfortran 4.5.0) is
required. GNU gfortran 4.5.0 is installed as part of the EasyS5 installation. However, certain
features require one of the other Visual Fortran compilers. See “Required Software” for more
information.

The following additional requirements may apply based on certain conditions:

« If you have a concurrent license, you need to have installed network TCP/IP software before
running Easy5. This software provides communication between the MSC License Server and
Easy5. See “TCP/IP Network Software” for more information.

Note: There is a limitation in Windows 10 that may affect the layout of Easy5 items in the Start
menu. If you have more than one Easy5 version on your Windows 10 computer, the Easy5
Start Menu features for the second and subsequent installations may be limited or
incomplete. In that case you will need to access Easy5 features from the desktop icon if
they are missing from the Windows Start menu. All features are still available, but they
may not be available from the Windows Start button.

This limitation does not apply to Windows 7.
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Hardware and Software

Hardware Recommendations

For reasonable Easy5 performance, the following hardware is recommended:

« Atleast 1 GB of physical RAM.

+ A video display card and 17-in monitor combination providing 1,280 by 1,024 pixels of graphics
resolution at 75 Hz or greater with 256 colors. We suggest a dual-view monitor configuration,
actually.

« Atleast 300 MB of additional free disk space for storing user files on your hard disk.

Required Software

The following sections describe the software required to install and run Easy5.

Fortran Compiler
Easy5 requires the use of a Fortran compiler to enable compiling and linking of your model executable
file. In addition, the compiler provides an object library manager and debug environment.

Easy5 currently supports the following Fortran compilers:

 Intel Visual Fortran versions 13.1.3.198 build 20130607 or newer.
« GNU gfortran Version 4.5.0(Mingw) *

*included with your Easy5 installation.

GNU gfortran is included in the EasyS5 installation. However, certain features are not available with
gfortran. These features include export of Easy5 models as MAT emx files or Adams XFE files, or 64-
bit executables.

During the installation, you are prompted to specify the appropriate Fortran compiler. If no other Fortran
compiler has been installed, GNU gfortran will be the default choice. If the specified Fortran compiler
has been installed, Easy5 Setup configures Easy5 to use the specified compiler.

The compiler software can be installed after EasyS is installed; it is recommended, however, that it be
installed before installing Easy5 so Easy5 Setup can correctly configure Easy5. Otherwise, simply
perform a Maintenance update via the Control Panel/Add/Remove Programs. See “After Installing Easy5”
for more information.

Caution: If Microsoft Visual Studio is installed, it must be VS 2010, version 10.0. The Linker must
be from VS 10 or greater.
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C Compiler

For certain operations, Easy5 also requires the use of a C compiler to enable exporting an object or
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Hardware and Software

creating an executable. These operations are summarized in the following table:

Intel & AMD x86-64
Windows
Interfaces with Other Tools
Siardal Matlaby/
andaione with Adams Simulink FMI
Models
Function ESL
Evaluation™* Co-Sim™* Import”™ Co-Sim® All functionality
Required if VISL:lal C_ Required if Required if there
there are C required if there are C C User Cad
Compatible | Required for C User Code there are C User Code | Visual Ce+ are L LsEr D_ =
C/Ce+ LS components User Code components required CDmpDﬂEStsl "
Compiler | Componentss _ P components - : - EasySmode
in Easys i in Easya
in Easys
model model
model

*Adams requires Intel® Fortran
““Intel® Fortran & Visual C-++ recommended
#MATLAB/Simulink® requires Intel Fortran

Easy5 currently supports the following C compilers:

 Visual Studio 2010 v. 10.0.30319 or newer.
* GNU gec/g++ Version 4.5.0(Mingw) *

*included with your EasyS5 installation

Note: The Visual Studio Shell that ships with Intel Fortran may not contain a C compiler. Hence
you will be unable to perform the operations in this section. Intel recommends a compatible

Visual Studio Community or Professional edition, with C++ component installed.

TCPI/IP Network Software

If you will be using a “concurrent/campus” license, your computer must also have network TCP/IP
software installed, which is used for communication between the MSC License Server and Easy5. A
“node-locked” license does not have this requirement.
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FLEXIm License Server

Easy5 2018 utilizes an MSC License Server for any “concurrent/campus” license. The MSC.Licensing
software must be installed separately from Easy5 (and can be done so from the first menu option during
installation).

Note: Easy5 2018 requires MSC License Server (FLEXIm) v11.13 or greater (installed
separately). Easy5 2017 required MSC License Server 11.9, so you may need to update
your MSC License Server installation before installing Easy5 2018.

Adams Controls Compatibility

Easy5 2018 is certified to work with Adams Controls 2017.2, the companion product that allows Easy5
models to be used in conjunction with Adams. Please consult the current version of the MSC Adams
documentation at the Adams support site (SimCompanion — Product Info and Docs — Supported
Versions of Integrated Products) to confirm compatibility with EasyS5.
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Other Software

If you plan to utilize the Easy5 User Code Component in C language, which gives you the capability of
coding user-defined components directly in C, then you will also need an Easy5 compatible C compiler
installed on your computer. In particular, the Intel Visual Fortran compilers require specific Microsoft
C++ compiler environments to function correctly -- please consult your Intel Visual Fortran compilation
documentation for more details.
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Overview

Overview
You can install Easy5 software in a variety of configurations that depend on any of the following:

« What kind of license you request.

* Where and how Easy5 license management software is installed.
» Where and how EasyS5 program files and settings is installed.

« How your local computer network is configured.

* Whether Easy5 has been previously installed.

The following sections provide an overview of considerations for installing Easy5.
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Universal Naming Convention Paths and File Sharing

The Windows operating systems provide two ways of accessing files from the network. The first is called
drive-mapping, a method used to map a drive letter to a network path. The second method is called
universal naming convention (UNC) paths, which uses a unique “shared” path description of the form:

\\computername\sharename\path

This format identifies a previously “shared” file path to a given network computer. Drive mappings are
less reliable because they only apply to a particular computer and must be reestablished each time you
start your Windows session, which can be time-consuming.

For these reasons, it is recommended that you use UNC network share paths instead of drive mapping
when referring to license files on other computers by their path. This is required if you need to “point at”
an existing license installed on a different computer during an installation of Easy5 on another computer.

For UNC paths to be visible, the top-level folder must be share-enabled. Allowing a folder to be shared
makes it visible to the network. Note that you cannot use UNC paths even from a local computer pointing
to itself without enabling sharing of the folder. See your Windows help for further information on file
sharing.
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Minimum User Privileges

The Windows operating systems provides a multi-user environment with a high level of security, so only
specific users of your computer can perform certain operations. Three so-called “Groups” are relevant
for Easy5 purposes: Administrators, Power Users, and Users. Administrators have complete and
unrestricted access to the computer, while Power Users possess most administrative powers with some
restrictions.

Users can operate the computer and save files, but cannot install programs requiring registry changes
(such as Easy5) or make system changes (required for performing an Easy5 Per-User Setup).

EasyS5 Setup requires the following minimum group membership for individual users:

Installer of Easy5 with a node-locked license Non-Restricted

User of Easy5 (for executing a Per-User Setup) Non-Restricted*
*Non-Restricted = ability to modify/set registry keys in the HKLM/Software registry hive.

For installation of an Easy5 concurrent license, specific license management files may need to be
installed to a Windows system directory. Therefore, Easy5 Setup cannot continue with a concurrent
license installation if you do not have Administrator group privileges. See Chapter 7: Introduction to
FLEXIm for information about licensing.

For other Easy5 installers or users, Non-Restricted access is required to enable the Easy5 Setup to make
required program-specific registry settings changes. Individual users of Easy5 should each perform a
Per-User Setup to properly configure EasyS for their use. This requires a minimum of Power Users group
privileges, and should be performed as the actual user (not the Administrator).

See “Per-User Setup” for more details. Please contact your local system administrator to help you
properly configure Easy5 installer and user group access (privileges).
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Options for Installing Easy5 Files on Your Computer

The following sections explain the requirements and options that you should keep in mind when deciding
how to install Easy5. The operation of the licensing system is described in more detail in Chapter 7:
Introduction to FLEXIm.

Node-locked license:

+ An Easy5 node-locked license file is provided, for operation of Easy5 on a computer with a
specific MAC (ethernet) address specified in the license file.

¢+ There is no limit to the number of simultaneous Easy5 executions.

* You can only use Easy5 on the computer with the appropriate MAC address as specified in the
license file.

* You can launch Easy5 from a laptop computer without any network connection.

Concurrent license:

« Installation of MSC Licensing software is required before a concurrent license can be used
(contact MSC Software support).

+ Installation of program files and specification of the previously installed license file or
“port@host” designation is required.

+ Easy5 runs only up to the maximum number of Easy5 users (or tokens) provided by your
concurrent license.

+ Easy5 (the application or the licenses) can be distributed across a network.
+ The computer acting as the License Server is connected to the appropriate serial number (MAC
ethernet address for Windows, hostid for Linux).

You can install a MSC License Server along with other FLEXIm-managed applications and license
servers. If the license file uses a License Server running on a Linux-based system, then no Windows
based serial numbers (hardware key, or MAC address) are required.

Note: You can only use Easy5 from a laptop computer when connected to the License Server
(and, of course, when using a concurrent license hosted by the License Server).
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Typical Installation Scenarios

The following scenarios are depicted in schematics, suggesting several typical configurations used for
installing Easy5. Note that where appropriate in the schematics, numbered steps denote the
recommended order of installation steps. These represent typical configurations, but not all possible
installation configurations.

A: Node-Locked Installation

This scenario is used exclusively for node-locked licenses. This is the simplest form of license
management and the best suited for portables.

-
n MSC.Easy5 Install

\L
| Hardware key (or MAC Address) |
- - - - — — — |

Individual Computer

|
|
| MSC. EasyE program files
|
|

A. Node-Locked Installation
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B: Centralized License Manager

This scenario is used to centralize license management from a given computer, workstation, or server,
but still install Easy5 program files on individual computers for top performance. MSC Licensing
software is installed separately and prior to Easy5 software.

2.Three MSC.Easy5 Installs

1. MSC.Licensing Install | | msc.Easys program flss

MSC.Easy5 program files

| MSC License Server

L____/__V\

| hostid, MAC address |

MSC.Easys program files

n Individual Computers

B. Centralized License Manager Installation (Concurrent License Required)

C: Centralized License Manager With Program Files

This scenario is very similar to scenario B except that the program files are also installed and available
for use from the computer hosting the License Server. Note that the License Server, which requires the
installed concurrent license file specification, should be installed before the Easy5 program files.

3.Three MSC.Easy5 Installs

T T - T T T T = 7| hostid | - - — — — — — _ _ .
| I | n Individual Computers |
| I | |
| MSC License Server M | MSC.Easys program files |
| 1.MSC.Licensing Install I 1| MsC.EasyS program files |
| MSC.EasyS program files /I/ |
| | MSC Easy s fil

2. MSC.Easy5 Install | sy program eS|
| (refers to installed license file) Lo ;|

C. Centralized License Manager With Program Files (Concurrent License Required)
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D: Existing Linux-Based License Server

If you are hosting Easy5 on both Linux and Windows operating systems, you can simplify your license
management by using the existing Linux-based License Server for your Windows computer. No
instructions are provided here for installing the Linux-based License Server; it is assumed that this has
already been done. The only requirement is that you can establish a TCP/IP-based network connection
between your computer and the Linux-based License Server.

1.LINUX License Server 2.Three MSC.Easy5 Installs
Install r—— - -- - - - 1
F—— — — — — — — - | | wscC.gasys program files
n LINUX Computer | ‘/I

MSC License Server

L — — — — — - - — MEC.EasyE  prodram files

|
|
MSC.Easy5s program files| |
|
[
|

| n Individual Computers

D. Existing { INUIX-Based License Manager (Concurrent License Required)

E: Alternating Between a Node-Locked and a Concurrent
License

This scenario can be used to provide license management to a variety of networked PCs, where one or
more computers (for example, laptops) may be disconnected from the network from time to time. It
requires at least two licenses: a concurrent license (on the network), and a node-locked license.

Use of a hardware key for the node-locked license allows for additional flexibility as to which computer
can be disconnected. See also Scenario F for information on running two concurrent licenses. The node-
locked license provides all that is needed for the computer that is using it, and is often the simplest way
of providing license management especially if the portable computer varies.

Easy5 Home Menu




Chapter 2: Things to Consider | 19
Typical Installation Scenarios

The hardware key can be physically shared among several PCs by alternating which computer is
connected to the hardware key and by setting the environment variable MSC_LICENSE_ FILE as needed
before launching Easy5 from an Easy5 Command Shell.

________ P —
"1 MSC.Easy5 Install '; | n_MSC.Licensing Instal

|

MSC.EasyE program files I | MSC License Server |

— ;{ — .
hardware key

k

concurrent
license

E Switching Befween a Mode-Locked or Concurrent Ucenses

Note: Use either environment variable MSC_LICENSE FILE or ALT_EASY5_LICENSE (and
USE_ALT EASY5 LICENSE).

F: Alternating Between Two Concurrent Licenses

This scenario provides license management to a variety of networked computers, where one computer
(for example, a laptop) may be disconnected from the network from time to time. It requires at least two
concurrent licenses, each with a minimum of 1 seat per license feature: a permanent concurrent license,
and a portable concurrent license. Both licenses can be tied to either a MAC Address (ethernet serial
number) or a hardware key; the latter providing greater flexibility because it ties the license server, not
to a particular PC, but rather a particular key, which can be more easily moved.

Thus, two separate License Server installs are made on two different computers, each with their own
concurrent license file. When the portable computer is connected to the network, any user on the network
can access its license as needed or available.

This requires you to set the environment variable MSC_LICENSE_FILE to the concatenated path of the
two licenses files enabling either license server to provide a license when needed. When the first license
is unavailable, the second license will be automatically checked. Therefore, when the portable computer
is disconnected from the network, its license server becomes unavailable to the network, but is still
available for use to the portable computer.

For example, assume that machine Netl is the permanent license server, and machine LapTop is the
portable license server. Each server has a concurrent license, and is given the two UNC paths:
\\Net1\EzLicMgr\lmgr\msc.lic, and \\LapTop\EzLicMgr\msc.lic, respectively. Each user
then assigns the environment variable MSC_LICENSE_FILE to the following value:
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\\Netl\EzLicMgr\lmgr\msc.lic;\\LapTop\EzLicgr\msc.lic

"1 MSC.Licensing Install #1

I |MSC License Servar | [ f_ — — — — — — — —
n MSC.Licensing Install #2

3

Lo _ . _ 1 | I
"portable” -

oncurent licemss +| MSC License Server | |

L 4

SR 1
concurrent licgase | & MSC.EasyS Install

MSC.Easyh f\':'!SC.EaS?,IfS
User 2 k partable /

F Using Two Concunent Licenses

MEC.Easy b
Lser 1

An alternate method would be to use the port@host specification method for both computers. If the
permanent license server is accessed using 1700@Net 1 and the laptop by 1700@Laptop, then assign the
environment variable MSC_LICENSE_ FILE to the value 1700@Net1;1700@Laptop.
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Pre-Installation Procedure

The following steps are recommended before installing the Easy5 software:

1. Decide which Easy5 installation type best suits your requirements and constraints. See
“Things to Consider” for more information.

To install most Easy5 license management software, you need Administrator group privileges.

2. Ensure that your current system date is correct. To check your system time, go to Start >
Settings > Control Panel and double-click the Date/Time icon. Changing the system date after
installing Easy5 can cause any Easy5 license to become invalidated.

3. If applicable, install Intel Visual Fortran compiler software on your computer (otherwise GNU
gfortran will be used). A typical installation is recommended for all supported compilers. If
prompted whether you want the Fortran environment setup for use in your standard environment,
it is recommended that you select No.

If you do not have a Fortran compiler to install, Easy5 includes a free GNU compiler suite
(Fortran and C). If you want to continue installing Easy5 (without a Fortran compiler), and install
the Fortran compiler later please see “After Installing Easy5” for more information.

4. If necessary, install network TCP/IP software to enable a “concurrent” type license. To see
if the software is already installed: go to Start -> Control Panel -> System and Security ->
Administrative Tools -> Computer Management -> Services and Applications -> Services
and look for “TCP/IP”. If the software is not installed, see your local system administrator for
assistance.

5. Have the following three items ready from your EasyS5 installation package:
+ Easy?5 installation downloaded executable file or CD.
+ EasyS5 license file specification (as a file path, or preferably, as a port@host string).

6. Uninstall existing versions of Easy5 (optional). Every release of Easy5 is installed in its own
registry and default destination folder, so older releases can be retained, if desired.
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Silent Install
A so-called "silent install" can be setup for Easy5 2018, by:

Step 1: Running a standard installation (using the GUI) and specifying the recording of a "response
file".

Step 2: Running a silent install and specifying a "response file" to read from.
This is done as follows:
1. Run the EasyS5 install per the command-line invocation (from a shell prompt):
path\setup.exe -r [-£f1 “response_file path”]
2. Run the EasyS5 silent install per command-line invocation (from a shell prompt):

path\setup.exe -s [-£f1 “response_file path”]

Where:
The default response_file path = $WINDIR%\setup.iss

The square brackets (" [ 1") are only used to denote an optional argument.
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Install Procedure

Note: The InstallShield installer will recommend that all programs be closed before running the
Easy5 2018 installer. We recommend that you first reboot your computer, then install
Easy5 2018 before starting any other programs.

To install Easy5 on your computer running Windows, please perform the following steps:

1. Insert the Easy5 installation CD into your CD-ROM drive, or if you are not using an installation
CD, select the installation executable downloaded or delivered from MSC.

2. Start the Easy5 Setup program.

+ If you are installing from CD and the autorun feature in Windows is enabled, the initial
window will appear automatically.

3. After selecting Next, you are presented with a Customer Information dialog. Note that if you have
adequate privileges, you will be prompted whether or not to install the software for all users. This
means that Easy5 shortcuts are enabled for all users of your computer. This is the recommended
installation scope, as it allows other users to run Easy5 from your computer, when available. If
offered, we recommend you select this option.

4. EasyS Setup prompts you for Setup type and destination.
By default, all available components are installed with the Full default option. However, you can
elect what components to install by selecting the User Selectable option. A third option, Client
installation is used to setup local shortcuts to utilize an installation of Easy5 on another computer.
See the section “License File” for more information on a Client install. For all Setup Options, you
may override the default destination path with the Browse button.

5. After you select Next, Easy5 Setup prompts you with a confirmation dialog before beginning the
installation of files. Select the Next button to install the software.

A progress bar will appear in the lower right-hand corner, indicating installation progress.
Depending on the number of components selected, and the hardware being used, installation of
the all files (about 200 MB) should take no more than 15 minutes of time (but typically, less than
a few minutes).

6. EasyS Setup prompts you to select a Fortran compiler.

If you have already installed a Fortran compiler, it is automatically selected as the default.
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Easy5 requires the use of a Fortran compiler to build executable versions of your model. By
selecting a compiler, Easy5 Setup configures Easy5 for use with the selected compiler. In
addition, Easy5 Setup will setup Easy5 for all Fortran compilers found installed, so that you can
change compilers easily later. To change the Fortran compiler used after installation of EasyS5, see
“Updating Your Fortran Compiler” for more information.

Note: If you will be only using an Analysis Only license, then you can select No Compiler. This
will remove requirements for a Fortran compiler, but also disable any ability to rebuild
Easy5 model executables.

7. EasyS Setup prompts you for an EasyS working folder.

The working folder is the default folder where EasyS5 is launched from. Please refer to your
Release Guide for more information about working folders.

If you are installing a common group installation, other users of Easy5 on this computer will need
to perform a Per-User Setup.

8. EasyS5 Setup prompts you for the license path specification.

Specify the license file path depending on the type of license you are issued and whether you want
to install EasyS5 license management programs on your computer:

« If you have a node-locked license, specify the full path of the license file in the Easy5 License
File Path field and click Next.

¢ To utilize an existing MSC License Server (installed previously on your or another networked
computer or server) for license management with a concurrent/campus type license, either:

a. Specify the full path of the installed MSC license file
b. Specify the path of a local copy of the installed MSC license file

c. Specify the port@host TCP address for the previously installed license file, and click Next.
This is the preferred method for a concurrent license.

d. Ifthe license file is on a network, use its UNC path (see “Universal Naming Convention Paths
and File Sharing” for more information). Note that the Browse button only displays the
directory structure, not individual files.

9. EasyS Setup displays a final confirmation window.

When you click [Finish], you have successfully installed Easy5. You may need to restart your
computer to install license management drivers and related license services and to update any
executable programs that may already be running. To view the README file, select the
appropriate check box. This file contains information about the current release.
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Per-User Setup

After installing Easy5 program files on this computer, other users of EasyS5 (if installed as a common
group) still need to be configured for use with Easy5.

This step is already completed for the installer by Easy5 Setup. Thus, the following action is required at
least once for all other current and future Easy5 users of this computer:

+ After each (additional) user logs in to the computer (for the first time after Easy5 has been
installed), they should perform a “Per-User Setup” from the Start Menu > Programs > Easy5
2018 > Per-User shortcut.

Running this shortcut, which invokes a local instance of Easy5 Setup, requires a minimum of
Power Users group privileges for each user.
Easy5 Setup then performs the following tasks:
+ Allows the user to specify (and create) a personal working folder (although a common one can
be specified)

 Properly configures Easy5 (certain required registry settings can only be made when each user is
actually logged in).

Important: Please note that without such a “Per-User Setup,” Easy5 will NOT be properly configured
for use for users other than the installer.
Also, a minimum of “Non-Restricted” privileges are required to execute this step. Finally,
if offered the choice, this installation should always be performed as the actual user, not the
Administrator.
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Fortran Compiler Installation Options

If you wish to use the Intel Fortran compiler with EasyS5, it is best to install it on your computer before
you install Easy5. Otherwise, Easy5 will be configured to use the MinGW compiler that is always
provided by the EasyS5 installer.

After EasyS5 installation, some additional scenarios are also possible:
« Installing or updating an Easy5-compatible Fortran compiler locally after Easy5 has been locally
installed.
+ Installing a different Easy5-compatible Fortran compiler after Easy5 has been locally installed.

« Using an Easy5-compatible Fortran compiler installed on another computer after Easy5 has been
locally installed.

« Switching from one compiler to another (if you have multiple compilers installed).

During your Easy5 program installation, a batch file called EZSVARS.BAT is created and stored in your
top-level Easy5 program directory, given by the environment variable EZHOME. After Easy5 Setup has
determined which compiler is to be used, it automatically updates the file EZ5SVARS . BAT with this
information by setting certain local environment variables. If it cannot find the appropriate version of
Intel Fortran locally, Easy5 Setup completes the installation with the MinGW Fortran compiler
configuration.

Certain environment variables used for compilation and linking steps. These environment variables are:

« PATH: Path(s) where the compile, library-manager, and linker commands are
located (required).
- LIB: Path(s) where Fortran and C run-time libraries are located (required).

« INCLUDE:  Path(s) where Fortran and C include files are located (optional).

While these variables can be set as global variables (see the section on environment variables in your
Release Guide), EasyS is installed to set these values in your local Easy5 environment using the batch
file $EZHOME% \EZ5VARS . BAT. Thus, to update these values, you either need to reinstall Easy5 (Program
Files) or manually edit this file. Specifically, for the cases previously outlined, you can take the following
steps:

1. Switching from one installed Fortran compiler to another.

Prior to launching Easy5 set environment variable EZ5 2018 FORT COMP to the appropriate
value: (see Table below). Please note that this will only work if the setting you choose has a
corresponding Fortran compiler installed.
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EZ5 2018_FORT_COMP Fortran Compiler

GNU GNU gfortran 4.5.0
IFORT Intel Visual Fortran (w/ MSVC11) on
32-bit processor
EM64T IFORT Intel Visual Fortran (w/ MSVCI1 on
EM64T 64-bit processor)

2. Installing an EasyS-compatible Fortran compiler after EasyS has been installed.

You need to update EasyS5’s initialization scripts so that it recognizes where the compiler is
installed. This is done using a Maintenance (Modify) Update.

After installing the compiler software, go to Control Panel Add/Remove Programs, select the
Easy5 2018 installation, and select Change/Remove.

An Install Shield dialog appears that offers you the choice of Modify, Repair or Remove.

Select Modify and you will be prompted to select components for installation or removal (if you
don’t want to change components that get installed, don’t select anything).

When prompted, select the appropriate Fortran compiler, and the Next button. Easy5 Setup will
reconfigure your environment to use the specified Fortran compiler.

3. Installing a different Easy5-compatible Fortran compiler after EasyS has been installed.
Reinstall Easy5 using Maintenance (Modify) mode as described in Option 2.
4. Using an Easy5-compatible Fortran compiler installed on another computer.

While the Fortran compiler software is usually installed on your local computer, it can also be
accessed across a local area network.

Although installing the Fortran software locally ensures better performance and is the standard
for most personal computers today, it is possible (although not recommended) to use a Fortran
compiler installed on a network server for use with EasyS5.

In this case, you must edit file EZ5VARS . BAT and provide appropriate paths for PATH, LIB, and
INCLUDE variables.

Caution: If you use a Fortran compiler installed on another computer, you are responsible for
adhering to software licensing agreements for your Fortran compiler.
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Overview

Easy5 uses the Flexible License Manager (FLEXIm) from Flexera Corp. Regardless of whether you have a
concurrent or campus type license, you will need to have a FLEXIm (MSC) License Server running. A
license server is comprised of a vendor daemon program and a license daemon program, as described
below.

All software required to run FLEXIm with existing license daemons is supplied with Easy5, including
the FLEXIm license file template (1icense.dat). The daemon programs run in the background to
manage the Easy5 licenses. This section gives you, as the system administrator, a general overview of
FLEXIm and how Easy5 licenses are managed, and explains the basics of floating (network) licensing
and gives a quick overview of the FLEXIm components. It explains where system administrators have
control and where end users have control.
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Introduction to FLEXIm

FLEXIm is a network license manager used by many software developers to control the use of their
software products. FLEXIm allows software licenses to be available (float) anywhere on a network,
instead of being tied to specific machines. Floating licensing benefits both users and system
administrators. Users can make more efficient use of fewer licenses by sharing them on the network. You
can control who uses the licensed application and the node or nodes where the licenses are available.

Types of Licenses

A concurrent license limits the maximum number of simultaneous users of a given set of license features
within a given site. A campus (or Masterkey) license is essentially the same, but allows access to all
possible license features, which are limited only by a maximum token count that can be used at any one
time. Both of these licenses are referred to as floating. Please contact your MSC Software sales
representative for more details on campus licensing.

Typically, an MSC License Server (a separate program from Easy?) is installed on a network server to
administer the floating licenses within a local area network. The Easy5 program files are then either
loaded on individual computers or only on the network server.

A node-locked license is used to run Easy5 on a given computer. The number of Easy5 applications
running at any given moment is limited by the number coded into the license file. The advantage of this
type of license is that no license server program is needed; the licenses are tied to the hardware address
of the computer.

Both types of licenses use the license management software, which is designed to prevent tampering with
the system date. If the system date is modified after Easy5 has been installed, the Easy5 license will be
invalidated. Furthermore, a new license will not fix this problem. See the troubleshooting section in the
Release Guide for further information.

Caution: Please do NOT reset the system date after installing Easy5. This can invalidate any Easy5
license. Re-validation can be a difficult and cumbersome process.

FLEXIm Components
The four main components of FLEXIm are:
« License File (the EasyS5 license file is called 1icense.dat).
+ Application Program (Easy5).
 License Server (MSC).
+ Vendor Daemon (MSC).

License File

Licensing data is stored in a text file called the license file, which for Easy5 license file is typically named
license.dat. The license file is created by the MSC Software licensing staff and sent via email to the
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system administrator. It contains information about the server nodes and vendor daemons, and one line
of data (called a FEATURE line) for each licensed feature. A feature line contains an encryption code
based on the data in that line, the hostids (“host-id”, or a unique identifier for a computer) specified in
the server lines, and other vendor-specific data.

You can override the location where the license file is stored by setting the environment variable
MSC_LICENSE_FILE to point elsewhere, or by following instructions supplied with these installation
notes.

Multiple License Files. If your site has software from multiple vendors with incompatible license files
(because of different sets of servers), you can keep the data in separate files and set the
MSC_LICENSE_FILE variable to reference multiple files using a separator character between file names;
Windows it is a semicolon (*;”).

Alternate License Files. In some instances, it can be useful to switch between two license files. For
example, if you have a laptop computer, you may want to alternate between use of a concurrent license
and a node-locked license. In this way you can minimize the number of licenses required while connected
to the network, yet use a single node-locked license when traveling. A method for switching between two
license files is provided using the following two environment variables:

USE_ALT EASY5 LICENSE = Boolean flag
ALT EASY5 LICENSE

Path to alternate Easy5 license file

When USE_ALT EASYS5 LICENSE is set, Easy5 uses the alternate license file specified by

ALT EASY5 LICENSE. Otherwise, it uses the default license file. In this situation, first install Easy5 with
the default, preferably node-locked, license. Set the global environment variables ALT EASYS5 LICENSE
to the alternate license file path and USE_ALT EASYS5 LICENSE to false. Then, when using the
alternate license file, set the latter to true.

Application Program

Easy5, an application that employs FLEXIm licensing, is linked with the program module (called the
FLEXIm client library) that provides the communication with the license daemons. During execution, the
application program communicates with the vendor daemon to request a license.

License Server

Typically, an MSC License Server is installed on a network server to administer the floating licenses
within a local area network. The Easy5 program files are then either loaded on individual computers or
only on the network server. For a single or standalone installation, the server is installed on the same
machine as the Easy5 application. The server manages the License Manager and Vendor daemons.

Please note that the FLEXIm version of the MSC License Server must be greater than or equal to the
FLEXIm version linked into the Easy5 application programs.
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Note: Easy5 2018 requires MSC License Server (FLEXIm) v11.13 or greater (installed
separately). Easy5 2017 required MSC License Server 11.9, so you may need to update
your MSC License Server installation before installing Easy5 2018.

A node-locked license is used to run Easy5 on a given computer. The number of Easy5 applications
running at any given moment is limited by the number coded into the license file. The advantage of this
type of license is that no license server program is needed; the licenses are tied to the hardware address
of the computer.

License Manager Daemon

The license daemon, usually called 1mgrd . exe handles the initial contact with the client application
programs, passing the connection on to the vendor daemon. It also starts and restarts the vendor daemons.
FLEXIm permits multiple redundant license manager daemons on different server nodes, allowing you
to make your license available if any two out of three server nodes is running. Also, you do not have to
split your licenses among multiple servers or rely on any one machine.

Vendor Daemon

In FLEXIm, licenses are handled by running processes. There is one process, called the vendor daemon,
for each vendor that has a FLEXIm-licensed product on the network. Easy5’s vendor daemon is called
msc . exe. The MSC daemon keeps track of how many Easy5 licenses are checked out and who has them.
Note that the MSC daemon serves many other MSC Software products, including MSC Nastran, MSC
Patran, and MSC Adams, among others. If the MSC daemon terminates for any reason, all Easy5 users
would lose their licenses. Users normally regain their license when the daemon restarts.

Client programs (like Easy5) communicate with the vendor daemon through TCP/IP sockets. This
enables client programs and daemon processes to be on separate nodes in a network. The traffic between
the client and the daemon is machine independent, which means that any process can run on any machine
type or operating system, allowing a heterogeneous network.

Note: If you need to install either or both licensing daemons, you must download and install the
software (MSC Licensing FLEXIm) from the MSC SimCompanion website at
https://mscsoftware.flexnetoperations.com/control/mnsc/index first before installing
Easys.
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License Request Process

When the application program calls the FLEXIm client library to request a license, the following process
occurs:

1. The license module in the client application finds the license file, which includes the host name
and port number of the license manager daemon 1mgrd. exe.

2. The client establishes a connection with the license manager daemon and tells it what vendor it
needs to talk to.

3. The license manager daemon determines which machine and port correspond to the master vendor
daemon (if multiple redundant daemons are running) and sends that information back to the client.

4. The client establishes a connection with the specified vendor daemon msc . exe and sends its
request for a license.

5. The vendor daemon checks to see if any licenses are available and sends a grant or denial back to
the client.

6. The license module in the client returns to its caller with the grant or denial, and the application
takes the appropriate action.
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Configuring FLEXIm
You can configure most FLEXIm parameters by setting

« The location of the license file.

+ The location of all executables.

+ The location of all log files.

¢ The TCP/IP port number of clients looking for the license manager.

In addition, you can reserve licenses for specific users, nodes, or groups and control other license-related
options.
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Getting Started Checklist

As system administrator, you are responsible for setting up licensing on your system or network. If you
are an end user of the application and you are not be involved in installing it, then you can skip this
section.

In general, installing FLEXIm licensing requires the following steps:

1. Select your license server nodes and get their hostids.

2. Send the hostids to your MSC license administrator and obtain a license file (or the data to enter
in the license file) in return.

3. Determine how the new license file relates to any other license files that may already be on your
system, and install it appropriately.

4. Start 1mgrd (the license daemon) manually, or set it up to run automatically at startup, using the
separately installed software (MSC Licensing FLEXIm) on the server.
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License Servers and Hostids

Before running any FLEXIm-licensed program using floating licenses, you must set up your license
server node or nodes. You must select which node or nodes to run your license servers on and provide
the hostid of those machines to Easy5.

When you install Easy$5, the installation script automatically obtains the proper hostid (required by
FLEXIm license manager) for your machine and displays it during the installation procedure. However,
if at any time you need the proper hostid of your machine, you can use the following methods:

From the Start menu, Under Search Programs and Files, enter cmd. This will bring up a Windows DOS
shell. In the shell, type

ipconfig /all
Scroll up in the resulting printout, and find the entry
Ethernet adapter Local Area Connection

Under this entry, the hostid is given as the Physical Address. Remove the hyphens before using. An
example:

Ethernet adapter Local Area Connection:
Connection-specific DNS Suffix

Description . . . . . . . . . . . : Intel(R) 82567LM Gigabit Network
Physical Address. . . . . . . . . : 00-23-E8-9D-BC-17
DHCP Enabled. . . . . . . . . . . : Yes
Autoconfiguration Enabled . . . : Yes
Link-local IPv6 Address . . . . . : fe80::b45d:£fc18:d862:487b%10 (Preferred)
IPv4 Address. .. . . . . . . :182.151.1.64 (Preferred)
Subnet Mask . . . . . . . . . . . : 255.255.255.0
Lease Obtained. . . . . . . . . . : Friday, May 15, 2015 7:57:54 AM
Lease Expires . . . . . . . . . . : Saturday, May 16, 2015 7:57:54 AM
Default Gateway . . . . . . . . . : 182.151.1.1

The hostid is then 0023E89DBC17.

Note: If you have multiple network cards installed, you can have more than one MAC address.

You should use the primary MAC address.

After sending the hostid of your server machines to MSC Software support, the support staff will send
you a license file that enables the application software.

Once you have received a license file, you must install it on your system and start up the license server.

 If you have multiple FLEXIm-licensed products, take care to avoid licensing conflicts.

+ Easy5 has a default location in the <host directory>/easy5/Imgr subdirectory for your license
file. However, you can use any location you wish.

« Some vendors provide special scripts to start up the license daemon. If not, you can run the
1mgrd program directly. To automatically run 1mgrd at startup, you must modify your system
files. See the directions with the MSC License FLEXIm product.
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Testing Your TCP/IP Connection

Easy5 concurrent license management require that you are able to establish a TCP/IP network connection
between your computer and the License Server. First, you need to know the hostname of the License
Server. To determine the appropriate hostname, examine the existing concurrent license file and look
for the SERVER command line. The first argument is the hostname. You can test if your computer can
communicate with the License Server by entering the command

ping hostname

ina Command Shell where hostname is the name of the computer running the License Server. If
you get a return reply, then you have a TCP/IP connection established.
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Internet Domain Name Server (DNS)

In addition to establishing a TCP/IP network connection between your computer and the License Server,
the License Server host (computer name) needs to be found by your internet domain name server (DNS).
If the host computer is inside a local-area-network (LAN) this is often automatic. If the host is not
registered, you may need to add it to your /etc/hosts or equivalent file.
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Updating Your License

One of the most commonly performed license management tasks is updating the EasyS5 license. Typically,
this is required at least once a year for security purposes. When the license will expire in less than 45
days, you are informed how many days are left in your license every time EasyS5 is executed. This
information is displayed in a pop-up dialog, as well as in the Licensed Features dialog. You will usually
be contacted before your license expiration date for arrangements and instructions for renewing your
license. If not, please contact MSC Software Licensing.

For floating licenses, the License Server must be updated with the (new) license before it can be used by
Easy5. Do not overwrite the existing license file, located in the EasyS 1mgr folder. If needed, the
installation program does this for you. Verify that the license has a valid path for the DAEMON line, and a
valid SERVER hostname in the license file. The DAEMON line should have a path to the installed MSC.exe
vendor daemon, normally found in folder:

C:\MSC.Software\MSC.Licensing\1l1l.x
The DAEMON line should look similar to the following:
DAEMON MSC C:\MSC.Software\MSC.Licensing\ll.x\msc.exe

If the path to the daemon is incorrect, edit the license file and correct the path. The SERVER line should
look similar to:

SERVER <hostname> <value> <ports

where <hostname>= the hostname of the computer acting as the license server
<hostid>= the hostid of the license server computer
<port> = the port number (default = 1700)

1. If your license is a new or updated floating type: Use the appropriate MSC Licensing shortcut
and follow the email instructions provided with your license file provided by MSC. See the MSC
Licensing User Guide for details.

2. If your license is node-locked or is a previously installed floating license:
* Go to Start > Programs > Easy5 2018 > License > License Update.

3. Confirm your license update using the Administration Tools (below). Updating the server
license only updates the license used with the License Server installation. If EasyS5 is already using
this same concurrent license, there is no need to perform Step 2 above.

Using a Previously Installed Concurrent License

Two methods are described below to utilize a previously installed concurrent license when installing
Easy5 on a particular computer. Both methods require a TCP/IP connection between your computer and
the License Server. See the previous sections for information on testing this connection.

To use the following methods, the concurrent license must already be successfully installed on another
computer.
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Method 1: Linking an Installed Concurrent License File by its Network Address

Set the value of the environment variable MSC_LICENSE_ FILE in your .cshrc or the System
Environment Variables using the port@hostname format.

With this method, unless you know the correct port@hostname string, you may need to examine the
existing concurrent license file. There should be at least one SERVER line of the form:

SERVER hostname hostid port

Note the values for hostname and port, which are required to describe the license file managed by the
license server.

Method 1 Example

An examination of the previously installed concurrent license file indicates a SERVER line as follows:

SERVER neptune 0d87242d 1829
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To use this license file when installing Easy5 on a particular computer

Enter 1829@neptune as the value of the environment variable MSC_LICENSE FILE:

User variables for cginsbur

Variable Value

HOME SeHOMEDRIVE %% % eHOMEPATH %
MSC_LICEMSE ... C:VUsersicginsbur'DocumentsYicense.dat
Path C:'Program Files (x36)\CVSNTY,

TEMP %lSERPROFILE%:\AppDataLocal Temp

New.. || Edit.. || Delete

System variables

Edit User Variable

Variable name: MSC_LICEMSE_FILE

Variable value: 1829 @neptune

| o

Method 2: Installing a Copy of the Previously Installed Concurrent License File

Easy5 does not actually need to be able to “point to” the existing concurrent license for license
management purposes; this is simply so that the installation program can read the license file without
making a copy of it locally.

The installation program reads the license file not for license management purposes but to correctly
determine components for installation. Easy5 only needs to be able to communicate via TCP/IP with the
License Server wherever it may be installed on the network.
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This method consists of copying the previously installed concurrent license file to a suitable folder on
the computer where EasyS5 is to be installed.

Note: A “previously installed” concurrent license means a license with a valid SERVER and
DAEMON line that it is already hosted by an existing, and running license server.

The installation program copies the license file into the local Easy5 license manager folder. Then, when
EasyS5 is started, the license file points to the appropriate License Server on the network. In this case, the
only information needed is the License Server hostname.

1. Copy the existing concurrent license file from the computer hosting the License Server to the local
computer. Please do not copy the license file directly to an Easy5 program folder path, especially
the Imgr subfolder.

2. Either begin a EasyS5 installation by loading the CD or executing the installation file, or, if Easy5
has already been previously installed, go to Start > Programs > Easy5 2018 > License > License
Update.

3. When prompted for the license file folder, enter the appropriate local path for the copied
concurrent license file. Easy5 Setup always searches the default path C:\1icense first.

4. When Easy5 Setup is done, Easy5 should be configured to use the previously installed concurrent
license on the remote License Server. Confirm this by going to Start > Programs > Easy5 2018
> License > License Manager Status.
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Administration Tools

Easy5 provides options that allow you to check your license file, called 1icense.dat, and to check on
the MSC daemon to be certain the Easy5 license is running.

To display information contained in your license file, enter the command easy5x -1lic from any Easy5
Command Shell, or go to Start >Programs> Easy5 2018 > License > License Status. Information about
your site, expiration date, and a list of licensed features is displayed.

To obtain more information or to verify that your license manager is working properly, enter the
command easy5x -lmstat from any Easy5 Command Shell window, or go to Start > Programs >
Easy5 2018 > License > License Manager Status. Another method is to open Easy5, select the Help >
Licensed Features... menu item, select the License Information tab, and select the Update License
Server Status button. The dialog will display current license server status (from Easy5).
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Overview

You can uninstall the following Easy5 products from your computer:

« Easy5 2018
+ Easy5 Client 2018

Important: Before uninstalling Easy5, verify that you are not running any Easy5 applications by
checking your Task Bar. Uninstalling an application that is running can cause strange
behavior later (especially if reinstalling the same software again later).

To uninstall Easy5 products from your computer, use the following method:

1. Go to Start > Control Panel > Programs > Uninstall a program.

2. Select the product name of the program you want to uninstall and click Add/Remove.
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Installing the MSC Adams Controls Extension

Note: The combination of Easy5 2018 and Adams 2017.1 has been tested and verified. Other
MSC Adams versions may or may not work with Easy5 2018.

Installation of the Adams Controls Extension is performed automatically if Adams is previously
installed, and you answer Yes to the installer prompt asking you to install this component.

To manually install the Adams Controls Extension:

1. Verify that both Easy5 2018 and Adams have been installed.

To install the Adams extension into Easy5, you must have permission to add files to and modify
files in the EasyS5 installation directory.

2. From the Windows Start menu, select:
Programs — Easy5 2018 — Shell — EasyS Command Shell
3. At the prompt within the command shell type:
install adams_controls.bat top-level-Adams-path $EZHOME%

where: top-level-Adams-path = Adams path (for example, C:\MSC.Software\Adams\2018).

The Adams extension installation is now complete.

Easy5 Home Menu
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